
What’s New

Digital images are everywhere—from the photography studio to the X-ray lab, 
from the glossy magazine to your website. With two new versions and a heap 
of new features and enhancements, wherever great digital images are found, 
Photoshop is there.

Adobe Photoshop CS4 refines and redefines the professional image-editing experience, with 
faster, nondestructive ways to accomplish core tasks like image adjustments and masks, and 
new tools and enhancements that let you work more easily, efficiently, and naturally. 

Photoshop CS4 Extended starts with the complete set of features found in Photoshop CS4, 
and adds others designed specifically for professionals working with specialized image 
types and multimedia workflows. With breakthrough 3D editing and compositing features, 
richer motion-graphics capabilities, and enhanced image analysis functions, Photoshop CS4 
Extended broadens your reach beyond traditional digital images.

ADOBE Photoshop CS4 
Extended
Discover new dimensions in digital imaging

ADOBE® Photoshop® CS4
Create powerful images with the professional standard

Adobe Photoshop CS4 is also available as 
a component of:
•	Adobe Creative Suite® 4 Design Standard

Adobe Photoshop CS4 Extended is also 
available as a component of:
•	Adobe Creative Suite 4 Design Premium

•	Adobe Creative Suite 4 Web Premium

•	Adobe Creative Suite 4 Production Premium

•	Adobe Creative Suite 4 Master Collection

This icon marks features in 
this document that are 
exclusive to Photoshop CS4 
Extended. All other content is 
common to both versions of 
the software.

+

Photoshop CS4 and Photoshop CS4 Extended feature a newly refined, tab-based interface in a single, integrated 
window, with self-adjusting panels arranged in docked groups. Automatically keeping tools well organized and 
away from your work area means you get greater efficiency, less clutter, and better results, faster than before.
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Top new and enhanced features in 
Photoshop CS4 and Photoshop CS4 
Extended
•	Live, nondestructive corrections 
with the Adjustments panel (page 2)

•	Re-editable, feathered, density-
controlled masks (page 3)

•	More refined, natural results with  
Dodge, Burn, and Sponge (page 3)

•	Enhanced Auto-Align, Auto-Blend,  
and new 360° panoramas (page 3)

•	Content-Aware Scaling (page 4)

•	Extended depth of field (page 5)

•	Fluid canvas rotation (page 5)

•	Ultra-smooth pan, zoom, preview, 
and painting tools (page 6)

•	Next generation Adobe Bridge CS4  
(page 6)

•	Tighter integration with Adobe 
Photoshop Lightroom® (page 7)

•	Camera Raw 5 with localized, 
nondestructive adjustments (page 7)

•	Breakthrough 3D editing and 
compositing (page 7)

•	Enhanced motion graphics (page 8)

•	Volume Rendering (page 8)

•	Easier data collection and analysis 
with the Count tool (page 9)

•	Unifed tabbed interface with  
self-adjusting panels (page 9)

•	Smarter Smart Objects (page 10)

•	More powerful printing options (page 10)

•	Higher performance on very large images 
(page 10)

•	Additional refinements (page 10)

•	Creative Pro Online Services  
(page 11)

With Photoshop CS4 and Photoshop CS4 Extended, you get:

Unrivaled editing power. New Adjustments and Masks panels slash the time it takes you 
to make nondestructive color and tone adjustments, and to create and re-edit feathered, 
density-controlled pixel and vector masks. With on-image controls and presets, there’s less 
time mousing between settings. Fine modifications are faster and easier with additions like 
the new Vibrance adjustment layer and enhanced Color Range mask creation. And Content-
Aware Scaling is the revolutionary new feature that automatically recomposes an image as 
you resize it, smartly preserving vital areas as it adapts to the new dimensions. 

Increased productivity. Work more efficiently and naturally with fluid, natural canvas 
rotation, enhanced pan and zoom tools, and effortless large-image navigation. Vastly 
improved Dodge, Burn, and Sponge tools let you intelligently and accurately adjust the 
exposure and color of image areas using simple brush strokes. Photoshop CS4 tools 
combine increased power and finer control with easier, more naturally controlled effects to 
boost productivity, no matter how you work with digital images.

Breakthrough 3D, motion graphics, and image analysis capabilities. In Photoshop CS4 
Extended, you can now work with 3D objects and video frames as easily as with any 
traditional image. Paint directly on 3D objects. Combine 2D layers and video files into 3D 
layers. Easily convert any image into a 3D object or volume. And do it all with a brand new 
3D engine that provides dramatic performance and capability improvements. In motion 
graphics, single-key shortcuts let you move through and edit video layers faster and more 
precisely than before, and new controls enable you to preview and export audio tracks as 
well. Image analysis improvements include multiple counts with the Count tool and volume 
rendering of DICOM files.

See what’s possible, with Adobe Photoshop CS4 and Photoshop CS4 Extended.

Top new features in Photoshop CS4 and Photoshop CS4 Extended
The new versions of Photoshop are about much more than just adding new features. They’re 
about providing you with best practices in the tasks you do daily—about making your work 
in Photoshop not just faster and easier, but more intelligent, and more natively 
nondestructive. Here are the top new features and enhancements in Photoshop CS4 and 
Photoshop CS4 Extended. 

Live, nondestructive corrections 
with the Adjustments panel
Photoshop CS4 speeds workflow performance with 
the Adjustments panel, cutting the time it takes to 
make nondestructive adjustments like Curves, 
Levels, Hue/Saturation, and much more. There’s no 
dialog box maze to navigate—just go straight to 
the task at hand. The Adjustments panel brings the 
right tool for the right job to your fingertips, 
dynamically, saving precious time. The panel 
features the new Vibrance adjustment, giving you 
greater control over color saturation while 
preserving delicate tones, such as skin colors. 
On-image adjustments are now available for Hue/
Saturation and Curves. Plus, for even greater 
convenience and time savings, the panel features a 
wide variety of modifiable presets for each type of 
change, including more than 20 new 
preconfigured, customizable starting points. The new Adjustments panel helps eliminate 

up to 90% of the mouse movements required 
to make nondestructive image adjustments.
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Re-editable, feathered,  
density-controlled masks
The new Masks panel smooths and speeds 
the creation and adjustment of pixel and 
vector masks, making it easier than ever to 
apply effects to precisely defined areas of an 
image. Now, with simple sliders, you can 
adjust the density and feathering of a mask, 
to control both the sharpness of the mask 
edge and how much of the adjustment effect 
you’d like to reveal. The Refine Mask feature 
allows simple yet fine-grained control over 
the mask size and edges. And Color Range 
has been upgraded for better accuracy and 
power. It’s a fast way to automatically create 
powerful and detailed masks based on single 
or multiple colors, with simple controls for 
the spatial tolerance and “fuzziness” of the 
color sampling.

More refined, natural results with 
Dodge, Burn, and Sponge
In the days of film, paper, safelights, and 
chemicals, photographers dodged and 
burned their prints during exposure, to 
darken and brighten areas of an image as 
they created it. It was an art that required 
steady hands and practice to master. The 
newly refined Dodge, Burn, and Sponge 
tools in Photoshop CS4 take the pain and 
practice out of preserving tonal quality 
while you spot-correct exposure and color saturation. Simply paint the area you want to 
adjust and get advanced results in a fraction of the time. 

Enhanced Auto-Align, Auto-Blend, and new 360° panoramas
The automatic alignment and blending technology in Photoshop CS4 enhances a wide 
variety of features, but nowhere are the improvements more obvious than in Photomerge®. 
Now, when you stitch a sequence of images into a panorama, enhanced blending combines 
with new vignetting and geometric distortion corrections to bring you even better 
results—a panorama with more natural colors blended from one end of the scene to the 
other. Additional improvements include the ability to create 360-degree panoramas, 

automatic detection 
of fish eye lenses to 
compensate for 
their inherent 
distortion, and the 
new Collage option 
which rotates and 
scales individual 
images as they are 
combined using 
Auto-Align and 
Photomerge. 

The Masks panel speeds precise mask creation and 
editing, with controls for density, multiple-color 
range selection, and effective edge refinement.

Color Range is now more versatile and 
effective. Automatically create powerful, 
detailed masks based on multiple colors, 
with better control over the selected range.

Spot color and exposure adjustments are more natural 
with the improved Dodge, Burn, and Sponge tools.

Enhanced Auto-
Blend technology 
automatically 
masks and blends 
frame edges for 
better results on 
panoramas. 
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Content-Aware Scaling
Imagine you have an image that is ideal for a new project, except the proportions are wrong. 
Maybe it’s a full-frame 8x12-inch photograph you want to fit into an 8x10-inch frame, or a 
8x10-inch image you want to crunch down to a panoramic, without sacrificing the people or 
important background. Up to now, getting these results was so time-consuming a process 
that it was virtually impossible. With Content-Aware Scaling, the near-impossible becomes 
the near-instantaneous success. Content-Aware Scaling is the revolutionary new feature in 
Photoshop CS4 that lets you resize and recompose simultaneously, with no more effort than 
it takes you to simply resize an image. As the name implies, the feature analyzes the image 
in the background while you adjust it, and intelligently recomposes the scene to preserve the 
most visually interesting areas. Content-Aware Scaling automatically recognizes skin tones 
to keep people from being squeezed out of the shot, and for more fine-grained control, 
selection tools let you easily define the most important areas before you begin scaling.

To begin, simply select any unlocked layer in a Photoshop document, and then either choose 
Edit > Content-Aware Scale, or press Command-Option-Shift-C (Mac OS X) or Ctrl-Alt-
Shift-C (Windows). Resize the image by dragging the corner or side controls, exactly as if 
you were doing a crop or free transform. If you want to define a protection area first, use any 
selection tool to select the vital area, then choose Select > Save Selection to save it as a new 
alpha channel. Choose a saved selection from the Protect menu to constrain the new 
composition when you adjust the 
image with Content-Aware Scaling.

The original photograph Resized to fit a narrow column width for a print layout or 
mobile device—the elements in the photograph are the same, 
but the perspective appears shifted.

Resized for use as a web banner

Intuitive controls on the options bar let you 
adjust the content to be protected from 
change during Content-Aware Scaling.
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Extended depth of field
Whether it’s the extreme close-up, the microbial world, or simply low-light conditions, there 
are times when the depth of field you can capture with your camera is extremely shallow. 
Now, you can shoot the scene with a series of focal points, and use the enhanced Auto-Blend 
Layers feature to automatically create a new, single image with a depth of field encompassing 
the entire series. You can even 
color-correct the images at the same 
time, automatically. This feature 
provides breathtaking enhancement 
of any scene where lighting and 
depth of field are in short supply.

Fluid canvas rotation
Photoshop CS4 introduces a revolutionary new feature that lets you paint and draw as easily 
and naturally as sitting down at an easel. With the new Rotate View tool, you can 
nondestructively spin your canvas to any orientation you desire—a boon to every illustrator, 
whether you paint by mouse or tablet. No pixel distortion, no craning your head to get the 
perspective you want, and no matter how you spin your canvas, Photoshop CS4 adjusts your 
selections, grids, rulers, and other tools and features to match your chosen orientation.

A range of shots, each 
with different exposure, 
color, and focal points 
(left) automatically 
becomes a single, color-
corrected, expanded 
depth-of-field image with 
Auto-Blend Layers.

Simply drag the new Rotate View 
tool outside the image area to spin 
your canvas to the orientation that 
works best for you.

Access the Rotate View 
tool in the new Application 
Bar at the top of the 
Photoshop application 
frame, or in the Tools 
panel, where it is grouped 
with the Hand tool.
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Ultra-smooth, extra-precise pan, zoom, preview, and painting tools 
Most modern computers contain a powerful graphics processor (GPU) that is almost like 
having a second computer inside the box. Photoshop CS4 leverages the power of your GPU 
with OpenGL technology to blast past the image-viewing restrictions of yesterday. Zoom all 
the way down to the level of 
individual pixels, with perfect 
clarity even at the oddest 
magnification percentages. 
Smoothly navigate around the 
largest images with no stutter or 
preview lag. Use the new Pixel 
Grid to easily edit images at the 
highest magnification. And revel 
in a faster, easier painting 
workflow, with brushes you can 
resize by dragging your mouse; 
new brush cursors that more 
clearly preview brush strokes 
before you make them; and 
improved, higher precision tablet tracking. Navigating very large images is easier than 
ever—instantly zoom high overhead to move to a new area of the image, and just as 
instantly zoom back in to the highest magnification. You can also “toss” the image across 
the screen with the Hand tool—the physics engine in Photoshop CS4 will give you a natural 
pan in any direction.

Next generation Adobe Bridge CS4
Finding, previewing, and managing all of your image assets jumps to a new level of power 
and convenience with Adobe Bridge CS4, beginning with faster performance from startup 
through to handing off images to Photoshop CS4. New path-bar navigation and workspace 
selection buttons across the top of the Bridge window let you instantly jump to just the right 
display for every task, including new Camera Import controls, visual folder navigation, and 

a new Carousel View for 
larger image-group 
selections. In the Output 
workspace, Bridge now 
features PDF-based 
contact-sheet creation and 
web-gallery creation and 
uploading. You can 
preview 3D images and 
panoramas created in 
Photoshop CS4. The new 
Search field helps you 
quickly find images in 
Bridge, and is also 
integrated with the 
Spotlight feature in 
Mac OS X and the 
Desktop Search feature in 
Windows® Vista™. You can 
even switch to the new, 
intuitive List View, with 
its familiar data display 
and sorting controls.

The new Pixel Grid appears at magnifications of 600% or higher, 
facilitating the finest detail editing.

Bridge CS4 makes it easier to work with all of your image assets, with intuitive, easily discoverable controls for camera 
import, viewing and sorting, contact-sheet and web-gallery creation. You’ll also find more versatile throughput to 
Photoshop CS4, including opening multiple files as a single, multi-layered image, and much more.
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Tighter integration with Photoshop Lightroom 2
Professionals and other advanced photographers rely on the one-two punch of Adobe 
Photoshop and Photoshop Lightroom software as the complete digital photography toolkit.  
Photoshop CS4 makes this workflow easier than ever, with improved cross-application 
support for automated functions, such as opening multiple photographs from Lightroom 2 
directly into a layered Photoshop document, high dynamic range (HDR) image, panorama, 
or Smart Object. Lightroom 2 and Adobe Camera Raw also share the same underlying 

technology, which means the changes 
you make with Camera Raw 5 in 
Photoshop CS4 are recognized in 
Lightroom 2, and vice versa.

Camera Raw 5 with localized, 
nondestructive adjustments
Providing the first step in the processing 
of raw data from your digital camera, 
Camera Raw now enables you to make 
localized adjustments by simply painting 
the area to be affected, and then using 
sliders to control the change. Additional 
enhancements include Post Crop 
Vignetting, and gradient-based localized 
correction. You can apply the same 
Camera Raw adjustments to TIFF and 
JPEG photographs, and, as always, the 
corrections you make are completely 
nondestructive, with the original files 
being maintained in their pristine state. 

Breakthrough 3D editing and compositing
With Photoshop CS4 Extended, you can now work with 3D models as easily and powerfully 
as you can 2D images, without navigating dialog boxes and special layer contents. For the 
first time, you can paint directly on 3D models, easily convert 2D images or gradient maps 
into 3D objects, and convert layers into volumes. Wrap a flat design onto a 3D object by 
merging the 2D layer directly onto your 3D layer. Merge two different 3D layers into a single 
scene. You can even use video layers as textures, to turn any 3D object into a video display 
zone. Basic presets will speed the process of turning two-dimensional designs into common 
3D shapes such as spheres and cylinders. You can also export 3D layers directly to the OBJ, 
KMZ, Collada, and U3D file formats. It all means that every creative professional can now 
take immediate advantage of three-dimensional assets created in today’s high-end modeling 

applications, and use them 
in their 2D mock-ups and 
composites. The 3D engine 
has been rebuilt from the 
ground up to provide 
dramatically faster 
performance; allow editing 
of properties like lights, 
materials, and cameras; and 
create more realistic 
renderings with a new 
high-quality ray tracer.

+

New Post Crop Vignetting lets you recreate artistic vignette effects in a photograph even after the 
original edge of the photo has been cropped away.

Enhancements to 3D support 
in Photoshop CS4 Extended 
include the ability to merge 
2D layers onto 3D layers—
effectively turning a 2D image 
into part of the 3D object.
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Enhanced motion graphics
Adobe Photoshop is an essential part of the motion graphics workflow, and Photoshop CS4 
Extended makes that workflow more efficient than ever, starting with the enhanced preview 
of non-square-pixel images. Easily preview and export the audio content of a video file as 
well as its frame comments. New keyboard shortcuts are enabled for the Animation panel to 
make fast work of editing between frames and keyframes. You can now animate the 3D 
object and camera position, render settings, and cross-sections, bringing new depth to 
motion-graphics editing. When working with 3D objects, you can even place video layers 
into your textures, turning any 3D object surface into a video display screen. Especially for 
film and television professionals, Adobe After Effects® CS4 can now directly read and 
import 3D layers from Photoshop CS4 files.

Volume Rendering
Volume Rendering is a new way to easily convert text, shape, or pixel layers into a volume. 
Artists can combine painted layers into entirely new and eye-catching 3D volumes. Motion 
graphics professionals can quickly turn text layers into animated 3D text. Medical 
professionals can volume render a DICOM image stack into a 3D anatomical image that can 
be viewed and explored from all angles and depths. Whether the goal is creative or scientific, 
Photoshop CS4 Extended adds exciting new capabilities with Volume Rendering.

+

+
Preview and export audio tracks and frame comments from the Animation panel in Photoshop CS4 Extended. 

With Volume Rendering, the 2D images from a 
DICOM stack (left) become  rich, 3D volumes 
that can be examined from any orientation.
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Easier data collection and analysis with the Count tool
Allowing fast, simple, point-and-click 
tallying of objects in scientific images, 
the Count tool is expanded in 
Photoshop CS4 Extended to allow for 
multiple counts, as well as separate 
colors for each count. This data is 
easily saved into the file for future 
reference, and can be collected in the 
Measurement Log panel for 
comparison and export to standard 
text files. 

Unified tabbed interface with self-adjusting panels
Photoshop CS4 helps you keep your work area efficient and clutter-free, with a new unified 
application frame, tab-based interface and self-adjusting panels. You’ll notice immediately 
how the Photoshop interface appears cleaner—instead of having to arrange multiple image 
windows, Photoshop does it for you with a tab for each open image. Docked panel groups 

keep to the side of your images, 
so you have fewer things to move 
around while you work. 
Individual panels expand and 
contract automatically to show 
you the controls you need, and 
you can even collapse entire 
panel groups to their header rows 
with a single click. Of course, 
you can still manually arrange 
floating windows and panels to 
suit your working style, even 
moving all of your panels to a 
second monitor if you prefer.

+

Perform multiple counts with the enhanced Count tool.

Working with multiple images is 
simple and clutter-free with the 
new tab-based interface.

Use the Arrange Documents 
menu in the new Application Bar 
to easily manage your view of all 
open images.
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Smarter Smart Objects
Smart Object layers allow for nondestructive scaling and transformation of Photoshop 
layers. With Photoshop CS4, you can now apply perspective transformations to Smart 
Objects, work with linked layer masks, and use the new Eyedropper tool option to sample 
either the current layer or all of the layers in the Smart Object at once.

More powerful printing options
Photoshop CS4 brings even higher quality to 
large, detailed images when taken to print. 
You can now preview out-of-gamut colors 
and take advantage of a streamlined printing 
interface. In addition, only on Mac OS X for 
this release, 16-bit printing is available for 
the first time, vastly increasing the color 
depth and clarity possible in printing.

Higher performance on very large 
images (Windows 64 only)
Photoshop CS4 has now been optimized to 
take advantage of even more RAM on 64-bit-
capable Windows PCs that are running a 
64-bit version of Windows Vista.

Additional refinements
The evolution of Photoshop software always includes a vast array of small but important 
improvements and additions. Extra refinements in Photoshop CS4 include:

Support for multi-touch gestures available on newer Apple MacBook Pro and MacBook Air •	
computers running Mac OS X Leopard
Clone Stamp and Healing Brush live preview cursor for easier, more precise cloning and •	
healing results
Layer-based metadata enabling reading and •	
writing strings to layer properties, such as 
recording time-stamp information for video
Developers of specialized applications can •	
create custom SWF-format panels that 
smoothly integrate with Photoshop CS4
Extensible SWF-based File Info panel, •	
enabling developers to add network-stored 
keywords, perform spell-checking, and 
other functions
Unique IDs per document for easier •	
downstream tracking of assets
CUDO technology, providing the ability to •	
design with sensitivity for color blind 
individuals via soft-proofing
Spring-loaded keys to temporarily shift between tools by holding down a tool shortcut key•	
FXG export•	
Device Link color profile support•	
Notes panel, to keep annotations from cluttering the canvas•	

The Clone Stamp and Healing Brush tools 
now feature a live preview of the source 
pixels at the cursor, making it easier than 
ever to precisely replace or heal specific 
areas of an image.

The File Info panel is now based on the SWF 
format, for greater extensibility.

Printing improvements in Photoshop CS4 
include 16-bit printing (Mac OS X only) and 
preview of out-of-gamut colors.
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Creative Pro Online Services
Photoshop CS4 gives you built-in access to a world of online resources with Creative Pro 
Online Services. Search for help; share your screen with colleagues or clients in a few clicks; 
create and share color harmonies; and more.

Adobe Community Help. Get the power of an online search engine with targeted results. 
Searchable content includes the in-depth Photoshop Help, plus additional Adobe and 
third-party content chosen by experts at Adobe and in the design and production 
communities. With Adobe Community Help, you can find the focused answers you need, 
fast, simply by choosing Help > Photoshop Help (Internet connection required). 

Adobe ConnectNow. Share your screen and collaborate in real time with colleagues, clients, 
and peers—regardless of their location—using ConnectNow. Show your desktop to two 
online guests at a time at no additional service charge. Exchange ideas using the 
accompanying chat pod, add a live video or audio feed to enhance your session, or use the 
annotation feature to allow guests to draw on the active screen. You can even temporarily 
hand over control of the screen to one of your guests so that they can make adjustments to 
your file. Simple to use, easy to access, and with reliable cross-platform support, 

ConnectNow allows you to more readily share knowledge, 
get immediate feedback, and streamline your work. Just 
choose File > Share My Screen to start a ConnectNow 
session (Internet connection required).

Adobe Kuler™. Explore, create, and share color themes 
with Adobe Kuler. Kick-start your creative projects with 
color inspiration from the online Kuler community. 
Browse thousands of themes by newest, most popular, or 
highest rated; or search themes by tag word, title, or 
creator. Themes can be downloaded and moved to your 
Swatches panel with one click. Or use an interactive color 
wheel that supports standard harmony rules to develop 
new color themes that you can save, move to your 
Swatches panel, and upload to share with others (Internet 
connection required for community functionality).

Adobe Bridge Home. Click Bridge Home in the Favorites panel of Adobe Bridge CS4 and 
stay up to date with what’s new from Adobe, and from the design, web development, and 
video and audio production communities at large. Watch the latest video tutorials for your 
Creative Suite 4 components, listen to a podcast interview with a leading designer, or learn 
about the next training event in your community. Discover tips and resources that can help 
you make the most of Photoshop CS4 (Internet connection required). 

Part of the Adobe Creative Suite 4 family
Adobe Photoshop CS4 and Adobe Photoshop CS4 Extended are important components of 
the Adobe Creative Suite 4 family of software. Creative Suite 4 Design Premium is 
everything a modern designer needs to create eye-catching images, breathtaking graphics, 
expert typography, precision layout, and high-quality production for print, web, interactive, 
and mobile content. Creative Suite 4 Web Premium is a complete solution for creating 
interactive websites, applications, user interfaces, presentations, mobile device content, 
Adobe AIR™ applications, and other digital experiences. Creative Suite 4 Production 
Premium is must-have software for creative professionals who need to craft world-class 
video, audio, and interactive media—on-air, online, on-device, and invariably on deadline. 
Creative Suite 4 Master Collection is the complete solution for customers requiring the 
ultimate power and versatility of the complete line of Adobe Creative Suite 4 components.

The integrated Adobe Kuler panel makes 
it simple to browse, create, and share 
color themes online.



Availability and pricing
Adobe Photoshop CS4 Extended will be available in North America for an estimated street 
price of US$999. Adobe Photoshop CS4 will be available for an estimated street price of 
US$699. Both can be obtained directly from Adobe or through Adobe Authorized Resellers. 
To order directly from Adobe, visit the Adobe Store at www.adobe.com or call 
1-800-833-6687. 

Licensed owners of Photoshop CS3 Extended, Photoshop CS2, or Photoshop CS can 
upgrade to Photoshop CS4 Extended for US$349.

Licensed owners of Photoshop CS3, Photoshop CS2, or Photoshop CS can upgrade to Adobe 
Photoshop CS4 for US$199. 

Licensed owners of Photoshop 5 or 6 can upgrade to Photoshop CS4 Extended for $899 or 
Photoshop CS4 for $599.

Licensed owners of Photoshop CS3 Extended, Photoshop CS3, Photoshop CS2, or 
Photoshop CS are also eligible for special upgrade pricing to certain editions of Adobe 
Creative Suite 4. 

A complete description of upgrade eligibility and pricing is available in a separate Pricing 
Overview document. For volume licensing information, contact an Adobe Authorized 
Licensing Center or go to www.adobe.com. 

Estimated street prices do not include taxes, shipping, handling, or other related expenses. 
Information on pricing and support policies outside of North America and for Education 
customers will be available separately.
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Mac OS
•	PowerPC® G5 or multicore Intel® processor

•	Mac OS X v10.4.11–10.5.4

•	512MB of RAM (1GB recommended)

•	2GB of available hard-disk space for installation; 
additional free space required during installation 
(cannot install on a volume that uses a case-sensitive 
file system or on flash-based storage devices)

•	1,024x768 display (1,280x800 recommended) with 
16-bit video card

•	Some GPU-accelerated features require graphics 
support for Shader Model 3.0 and OpenGL 2.0

•	DVD-ROM drive

•	QuickTime 7.2 software required for  
multimedia features

•	Broadband Internet connection required for  
online services

Windows
•	1.8GHz or faster processor

•	Microsoft® Windows® XP with Service Pack 2 (Service 
Pack 3 recommended) or Windows Vista Home 
Premium, Business, Ultimate, or Enterprise with 
Service Pack 1 (certified for 32-bit Windows XP and 
32- and 64-bit and Windows Vista)

•	512MB of RAM (1GB recommended)

•	1GB of available hard-disk space for installation; 
additional free space required during installation 
(cannot install on flash-based storage devices)

•	1,024x768 display (1,280x800 recommended) with 
16-bit video card

•	Some GPU-accelerated features require graphics 
support for Shader Model 3.0 and OpenGL 2.0

•	DVD-ROM drive

•	QuickTime 7.2 software required for  
multimedia features

•	Broadband Internet connection required for  
online services

For updates to system requirements, visit  
www.adobe.com/products/photoshop/photoshop/
systemreqs (Photoshop CS4) and www.adobe.com/
products/photoshop/photoshopextended/systemreqs 
(Photoshop CS4 Extended).

Expected ship date
Fourth quarter 2008

For more information
For more details about Adobe Photoshop CS4  
and Adobe Photoshop CS4 Extended, visit  
www.adobe.com/photoshop.



New and enhanced features compared Photoshop CS4 Photoshop CS4 
Extended

Increased Productivity
Fluid canvas rotation

Enhanced Pan, Zoom, and large image navigation

More refined, natural results with Dodge, Burn, and Sponge

Next generation Adobe Bridge

Tighter integration with Photoshop Lightroom

Integrated Kuler for color harmony creation and sharing

N-up and multiple document view

More powerful printing options

Superior performance on very large images*

Support for multi-touch gestures†

Extensibility with SWF panels

Unified tabbed interface with self-adjusting panels

Unrivaled Editing
Live, nondestructive corrections with the Adjustments panel

Re-editable, feathered, density-controlled masks

Enhanced Auto-Blend with seamless tones and colors

360° panoramas

Content-Aware Scaling

Extended depth of field

Camera Raw with localized adjustments

Enhanced Smart Objects

On-image controls for Curves, Hue/Saturation adjustments

Clone Stamp and Healing Brush preview cursor

Breakthrough 3D, Motion Graphics, and Image Analysis
Direct painting on 3D objects

Easy conversion from 2D to 3D

Editable 3D properties (scene, materials, meshes, lights)

New high quality interactive ray tracer

Create 3D composites with 2D images or other 3D objects

New, high-performance, non-modal 3D engine

Volume Rendering

Keyboard shortcuts enabled for the Animation panel

Enhanced preview of non-square-pixel images

Preview and export audio content and frame comments

Animate 3D objects and their textures

Enhanced Count tool

* Additional RAM usage requires 64-bit version of Windows and a 64-bit capable computer
† Requires newer Apple MacBook Pro and MacBook Air computers running Mac OS X Leopard
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